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IMPORTANT SAFETY PRECAUSIONS

—For U.S.A.

TO THE USER

This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reason-
able protection against harmful interference
in a residential installation. This equipment
generates, uses, and can radiate radio fre-
quency energy and, if not installed and used
in accordance with the instruction manual,
may cause harmful interference to radio com-
munications.

However, there is no guarantee that interfer-
ence will not occur in a particular installation.
If this equipment does cause harmful interfer-
ence to radio or television reception, which
can be determined by turning the equipment
off and on, the user is encouraged to try to
correct the interference by one or more of the
following measures.

a) Reorient or relocate the receiving anten-
na.

b

Increase the separation between the
equipment and receiver.

c) Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

2

Consult the dealer or an experienced
radio/TV technician for help.

CAUTION

Changes or modifications to this equip-
ment not expressly approved by TEAC
CORPORATION for compliance could void
the user's authority to operate this equip-
ment.

Declaration of Conformity
Model Number: Us-122L

Trade Name: TASCAM

Responsible party: TEAC AMERICA, INC.
Montebello, California, U.S.A.

Telephone number: 1-213-726-0303

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions:

(1) This device may not cause harmful interfer-
ence, and

(2) This device must accept any interference
received,

including interference that cause undesired oper-
ation.

2 TASCAM US-122L

This appliance has a serial number
located on the rear panel. Please
record the model number and serial
number and retain them for your
records.

Model number

Serial number
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IMPORTANT SAFETY INSTRUCTIONS

Read these instructions.

Keep these instructions.

Heed all warnings.

Follow all instructions.

Do not use this apparatus near water.
Clean only with dry cloth.

Do not block any ventilation openings.
Install in accordance with the manufactur-
er's instructions.

Do not install near any heat sources such
as radiators, heat registers, stoves, or other
apparatus (including amplifiers) that pro-
duce heat.

Only use attachments/accessories speci-
fied by the manufacturer.

Use only with the cart, stand, tripod, brack-
et, or table specified by the manufacturer,
or sold with the apparatus. When a cart is
used, use caution when moving the cart/
apparatus combination to avoid injury from
tip-over.

A —
~——

Do not expose this apparatus to drips or
splashes.

Do not place any objects filled with liquids,
such as vases, on the apparatus.

Do not install this apparatus in a confined
space such as a book case or similar unit.

*

*

*

Microsoft, Windows, and Windows XP
are registered trademarks in the United
States and other countries of Microsoft
Corporation, USA.

Pentium is a registered trademark of
Intel Corporation, USA.

MIDI is a registered trademark of the
Association of Musical Electronics
Industries.

Other company names and product
names in this document are the trade-
marks or registered trademarks of their
respective owners.

TASCAM US-122L. 3
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Please read this owner’s manual carefully
before you begin using the US-122L, and
use the product correctly as directed in
order to ensure long and trouble-free
enjoyment of all its functionality.

After you have read this manual, keep it

1 - Introduction

nearby for reference when required.

We can accept no responsibility for any
loss of the data you record using this prod-
uct onto other MIDI equipment in your
system or onto storage devices such as
hard disk.

Overview

The US-122L is a USB-based audio inter-
face designed for use with Digital Audio
Workstation (DAW) software. It provides a
two-input, two-output 24-bit 96 kHz audio
interface and a 16-channel MIDI interface.
Because the US-122L is USB-based, it is
the ideal companion to any desktop- or
laptop-based digital recording setup. And

since the US-122L operates using only
USB power, you can use it with a laptop
computer to create a very compact and
portable digital audio workstation system.
The US-122L is also an ideal way to cap-
ture analog sources such as records or cas-
sette tapes into your computer and pre-
serve them as audio CDs.

Features

24-bit / 96 kHz audio interface.

» Analog input signals (L, R) can be input
at the same time and recorded simultane-
ously into your computer via USB.

» Two XLR mic/line inputs (balanced) and
two 1/4” phone mic/line inputs (bal-
anced/unbalanced) are provided. One of
the 1/4” phone inputs can be switched to
allow direct input of an electric guitar or
electric bass (R channel only).

» Unbalanced stereo line output (RCA

connector) and headphone output.

* MIDI IN/OUT.

 Direct Monitor function allows zero-
latency monitoring of the input.

» Power is supplied by the USB connector.

A note about computer operation
If you are unsure about how to perform
basic computer operations appearing in
this manual, please refer to the owner’s
manual that came with your computer.

What is in the package

The US-122L package contains the follow-
ing items.

» US-122L main unit

» USB cable

* Owner’s manual (this document)

¢ CD-ROM (containing drivers and manuals)

* CD-ROM (Gigastudio 3 LE) [Windows
only]

¢ CD-ROM (Cubase LE)

TASCAM US-122L 5
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Conventions used in this manual

The following conventions are used in this
manual:

Front panel keys, knobs, and indicators,
and rear panel connectors are designated in
all-capital letters.

Example: LINE IN jacks

6 TASCAM US-122L

This typeface is used to designate messag-
es displayed by the software.

Example: Control Surface Protocol

This typeface is used to designate software
menu functions and on-screen controllers.

Example: ASIO Device
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2 — Parts of the US-122L

Top panel
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@ PHONES/LINE OUT level knob
Controls the output level of the LINE OUT
jacks and the PHONES jack.

(2 MIDIIN indicator Lights when MIDI
data is being received at the MIDI IN con-
nector.

MIDI OUT indicator Lights when MIDI
data is being transmitted from the MIDI
OUT connector.

(3 uUsB indicator Lights to indicate a
valid USB connection to the host comput-
er.

(4) MON MIX balance knob Controls
the balance of the signal sources being out-
put from the LINE OUT jacks and the
PHONES jack. When this knob is turned to
the far left, the signal being input to the
US-122L (from the XLR jacks, or 1/4"
phone jacks) will be output. When this
knob is turned to the far right, the output
signal received from the computer via USB
will be output.

(5) MONO switch Turn this switch ON if
you want to monitor in monaural. This
switch affects only the analog input signal.

(8 INPUT knobs (L, R) Adjust the level
of the audio signal being input to the MIC
IN jacks and LINE IN jacks.

TASCAM US-122L 7
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2 — Parts of the US-122L

@ SIG/OL indicators Light when signals ic musical instrument, audio device, or mic.
are being input to the input channels (L, (@ PHANTOM switch Turns on the +48V
R). They will light green to indicate a sig- phantom power supplied to the MIC IN

nal is present, and will light red immedi- jacks.

ately before distortion occurs. These indi-

cators apply only to the analog inputs. Microphones should not be connected
to or disconnected from the US-122L
These indicators will light green when with phantom power switched on.

the input signal level is in the range of - Unbalanced dynamic microphones

30 dBFS to -2 dBFS. The indicators will should never be connected to phantom-
light red when the input signal level powered connectors.

exceeds -2 dBFS.

MIC/LINE-GUITAR select switch Set Turn this switch on only if you are using
this switch as appropriate for the input condenser microphones that require

phantom power.

Please note that if you are operating
the unit with a battery-powered laptop
computer, the battery life of the com-

source you have connected to the LINE IN
jack R channel. Use the GUITAR position if
you have directly connected an electric

guitar or electric bass. Use the MIC/LINE puter will be reduced if the PHANTOM
position if you have connected an electron- switch is on.
Rear panel

©)

©
USB connector Use a USB cable to 3 LINE OUT L/R jacks (RCA connector,
connect this to the host computer’s USB unbalanced) These are analog stereo output
2.0 port. jacks.
(i) MIDI OUT connector Transmits NOTE
MIDI messages. If you connect headphones to the

PHONES jack, no signal will be output

@2 MIDI IN connector Receives MIDI from the LINE OUT jacks.

messages.

8 TASCAM Us-122L
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2 — Parts of the US-122L

Front panel
®w ® ®
hl o]
‘©e0s®
o o [oJe]
Dooo®
Yoo,
MIC IN (L, R) jacks (XLR balanced) If the MIC/LINE-GUITAR select switch is in
These are analog mic input jacks. The wir- the MIC/LINE position, the R jack operates
ing is as follows: pin 1 = ground, pin 2 = as a balanced input jack. (Sleeve = ground,
hot, pin 3 = cold. tip = hot, ring = cold)
@ LINE IN (L, R) jacks (TRS 1/4" phone PHONES jack (stereo 1/4" phone) This
jacks) These are balanced line input jacks. is a headphone output jack.
The R channel also accommodates guitar NOTE
input. If the top panel MIC/LINE-GUITAR If you connect headphones to this jack,
select switch is in the GUITAR position, the no signal will be output from the LINE
R jack operates as an unbalanced input OUT jacks.

jack for guitar.

TASCAM US-122L. 9
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3 - Installation

System requirements

Windows XP

Supported operating system: Windows
XP SP2

Recommended system: Pentium or
Athlon 1 GHz or faster (or equivalent pro-
cessor), 512 MB or more memory, USB 2.0
port

These requirements are for when using
Cubase LE. If you are using other applica-
tion software, you will need to consult the
operating requirements for the software
you are using.

NOTE

The number of usable audio tracks will
depend on the speed of your hard disk.

The faster your hard disk, the better
your results will be.

We recommend that you have at least
256 MB of memory, but when using dig-
ital audio application software, the
more memory you have the happier you
will be.

Although this product has been checked
for use with typical computers that
meet the above operating require-
ments, we cannot guarantee that it will
operate with all computers that meet
these requirements. Please be aware
that even under the same conditions,
processing capability may vary depend-
ing on differences of the design and
system.

Mac OS X

* Macintosh computer with a USB 2.0
connector

* Mac OS X 10.3.9 & higher on PowerPC
Mac systems

10 TASCAM US-122L

For Macintosh as well, the more memory
you have and the faster your hard disk, the
happier you will be when using digital
audio application software
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3 - Installation

Installing the drivers

In order to use the US-122L, you must
install the appropriate drivers into your
computer. As described below, this is an
easy process using the CD-ROM included
with the US-122L.

Drivers are updated from time to time. You
can download the most recent version of
the drivers from the TASCAM website
<http://www.tascam.com/>.

Do not connect the US-122L to your com-
puter before you have installed the drivers.

Handle the enclosed CD-ROM with care.
If the disc becomes scratched or dirty,
your computer may be unable to read it
and the software cannot be installed. If
the disc becomes unreadable, a fee will
be charged for its replacement.

WARNING

Never attempt to play the enclosed CD-
ROM in a conventional audio CD player,
as the resulting noise may damage your
speakers or your hearing.

Installing the drivers for Windows XP

The US-122L1’s drivers are provided on the
CD-ROM as an executable installer enti-
tled US-122L & US-144 driver x_yy.exe.
(X_yy is the version number.)

Installation procedure

1 Make sure that the US-122L is not
connected to your computer.

2 Double-click the executable installa-
tion file US-122L & US-144 driver x_
yy.exe. The installer will start up.

3 Select the desired language from the
menu and click the OK button. A dia-
log box will appear.

4 Click the Install the Driver button.
The drivers will be installed.

During driver installation, a warning
that this software ... has not passed
Windows Logo testing will appear. This
warning appears when you attempt to
install a driver that has not passed
Windows Logo testing; however, please
be assured that TASCAM has verified
that this driver for Windows XP does
work correctly.

If this message appears, click Continue to
proceed with the installation.

If a message asks you to restart your com-
puter, restart your computer.

After restarting, connect the US-122L to
your computer. The Windows Plug and
Play system will detect the new USB hard-
ware, and the Add New Hardware wizard
will start up. The wizard will automatically
find the necessary files. (This will take
about 30 to 60 seconds.)

The drivers are now installed, and the
US-122L is ready to operate.

TASCAM US-1221 11
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3 - Installation

Installing the drivers for Mac OS X

The US-122L1’s drivers are provided on the
CD-ROM as a package file entitled US-
1221 & US-144 driver x_yy.mpkg. (x_yy is
the version number.) Simply double-click

on this package file’s icon to launch it and
follow the directions that appear on your
screen.

Installing Cubase LE

1 Insert the Cubase LE CD-ROM into
your computer.
The opening screen will appear.

O steinberg

Cubasee.LE

Music Creation & Froduction System

InstallCubase LE__|
[ Install Acrobat Reader |

2 Click the Install Cubase LE button.

3 Enter the serial number of Cubase LE.
The Cubase LE serial number is
affixed to the soft case of the Cubase
LE disc.

4 When you have finished entering the
information, click the OK button.

5 Follow the instructions shown on the
screen with the installation.
When the installation is completed, a
dialog box indicating that installa-
tion was successful will appear, and
then you will return to the opening
screen.

6 Close the opening screen.

Settings on your computer

Here are a few basic points to help you set
up your computer for best performance
with audio applications.

* Do not run other applications. You will
probably use your computer for applica-
tions other than audio, but we recom-
mend that you avoid running other appli-
cations at the same time you are running
audio programs. Processing digital audio
places a considerable load on your com-
puter.

This means that if you are running other
applications (especially graphics or

12 TASCAM US-122L

Internet tools) at the same time as your
audio application, the processing may
not happen fast enough.

 Certain devices such as network cards or
WinModems can cause conflicts with
USB processing. If you experience such
a conflict, you can use the Device
Manager to temporarily disable the
offending device.

 If your computer has an IDE hard disk,
enabling Direct Memory Addressing
(DMA) will improve performance. In
Windows XP, this is enabled by default.

Download from Www.Somanuals.com. All Manuals Search And Download.



4 -

Control panel settings

Overview

The Control Panel lets you make various
settings for the US-122L’s functionality.
The Control Panel is divided into the fol-
lowing two sections.

Status section

This shows the current status of the driver
and the connected hardware.

You cannot edit the settings from this sec-
tion.

Setting section
Here you can edit the various settings of
the driver.

TASCAM

US-122L / US-144 Control Panel

Sanple Closk Sourcs

[sutonsic =

Audio Perfamance
[ normel lstency K|
USB 1.1 Mode Ingut Selection Digial Dulput Format

[analog B [s/PDIF ~

|
muted 441 kHz

Help Cancel

Driver settings

Audio Performance

The US-122L driver temporarily stores
input and output audio samples in buffers.
The Audio Performance setting lets you
adjust the buffer size. The Lowest Latency
setting is the minimum buffer size, and the
Highest Latency setting is the maximum
buffer size.

A smaller buffer size will reduce the delay
when monitoring the input signal, but will
require your computer to perform the pro-

cessing faster. If the processing does not
occur in time (e.g., if other system opera-
tions are occurring), you may hear clicks,
pops, or dropouts in the audio signal.

A larger buffer size provides more safety
against such problems caused by other sys-
tem activities, but will produce greater
delay when monitoring the audio signal.
The US-122L lets you select the buffer size
that works best for your system.

TASCAM US-122L 13
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5 — Connections

USB connections

Using the included cable, connect the
US-122L to your computer as shown in the
illustration.

USB ==

NOTE

Some USB devices access the USB bus
frequently. To avoid dropouts and clicks
in the audio signal, we strongly recom-
mend that you do not connect other
USB devices to the USB bus used by the
US-122L.

USB keyboards and mice are exceptions
to this, and will probably not cause
problems.

Audio connections

Connect the output signal of your mic, gui-
tar, keyboard, or other audio device to the
US-122L, where it will be converted into
digital audio and sent via USB to your
computer. Connect the output of the
US-122L to your speakers (via an amp) or
headphones, so you will be able to monitor
the audio signals coming into the US-122L
or being produced by your computer.

The US-122L has two input channels (L,
R), with a MICIN jack (XLR) and LINE IN
jack (1/4” phone jack) provided for each
channel. Do not connect signals to both
of these analog input jacks at the same
time. If both are connected, the signal
will not be correctly input to the
US-122L.

14 TASCAM US-122L

Mic

Connect your mics to the MICIN (L, R)
jacks (XLR). If you are using a condenser
mic that requires phantom power, turn on
the phantom power.

If you're using a
condenser mic

©

PHANTOM
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Guitar

Connect your guitar to the R-channel LINE
IN jack (1/4” phone jack) and set the MIC/
LINE-GUITAR switch to GUITAR.

Deog
|
:

Keyboard / drum machine /
sound module / cassette deck /
MD / CD etc. (analog connec-
tion)

Connect the analog audio output of these
devices to the LINE IN (L, R) jacks (1/4”
phone jack). If you use the R-channel, set
the MIC/LINE-GUITAR switch to LINE.

Fay

X
i

gl Keyboard /
drum machine /

sound module /
cassette deck /
MD / CD or similar device

A

Download from Www.Somanuals.com.

5 — Connections

Analog record player

The output of an analog record player can-
not be connected directly to the US-122L.
You must connect a phono amp between
your analog record player and the
US-122L. (Alternatively, you can connect
it via an audio amp that has PHONO
inputs.)

o

b4
||

Phono amp or
OouUT
amp with PHONO input

Analog record
player

Speakers/headphones

(90900)

r—

Powered speakers,
or amp and speakers

Headphones

TASCAM US-122L 15
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5 — Connections

MIDI connections

Connect your sound module, keyboard/
synthesizer, drum machine, or other MIDI
device to the US-122L as shown below.

Computer

MIDI OUT

Keyboard /
synthesizer etc.

MIDI IN
Sound module etc.

16 TASCAM US-122L

You can use the MIDI IN/MIDI OUT con-
nectors to transmit and receive MTC
(MIDI Time Code). This allows the MTC-
compatible DAW (Digital Audio
Workstation) computer application to syn-
chronize with your MIDI equipment.

Computer
MIDI OUT

Sequencer /

drum machine etc.
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6 — Recording with Cubase LE

This chapter explains the basics you will
need to understand when using the
US-122L with Cubase LE.

This discussion is not intended to replace

the user manual of your software.

If you have questions specific to Cubase
LE, please refer to the Cubase LE user
manual.

Input setting

1 Start up Cubase LE. From the
Devices menu, choose Device Setup.
The Device Setup window will
appear.

Transport | Devices  Window  Help
MIDI Device Manager

Mixer F3
Plug=in Information
WET Ihputs F&

WET Ihetruments F11
WST Master Effects F7
WET Qutputs F4
WET Performance F12
WST Send Effects Fé&
Wideo

Show Panel

2 From the device list in the left side of
the Device Setup window, choose VST
Multitrac.

3 In the right side of the window, click
the Setup tab, specify the AS/O Driver
for the interface that uses an ASIO
driver, and click the Apply button.

If you have connected the digital
input, set the Clock Source to exter-
nal.

ANMID! Inputs

Default MIDI Ports
Direchiusic
VST Hkirack

VST System Link.
Vicks Plaver
Windows MIDI

Contol Paret

"
O

b | oo | o |

4  From the Devices menu, choose VST
Inputs to access the VST Inputs win-
dow. Verify that the Port field shows
the input name of the audio interface
you are using, and that the Active
indicator is lit.

Transport | Devices  Window Help

MIDI Device Manager
Mixer
Blug-in Infor mation

VST Ihatruments
WET Master Effects
WET Qutputs

WST Performance
WET Send Effects
Wideno

Show Panel

Device Setup...

TASCAM US-122L 17
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6 — Recording with Cubase LE

5 From the File menu, choose New YT ——
Project. A window will appear, allow-
ing you to choose a template for your

new project. Choose the desired tem-

16 Track MIDI Sequenzer
plate and press the OK button. 24 Tranck Aulio Recorder

Templates:

Specify the location in which to save Default
your project, and the new project Music for picture NTSC
will be created Music for picture PAL

Stereo Maztering Setup

©Cubaze LE
File Edit Project Audio MIDI  Pool  Transport
Mew Project Ctri+M
Open... Cr+O
Glose e el
EavE Gl
. -
Save fz. ErlEshittss

SR e oK | Cancel |

Now you are ready to begin recording.

Recording
1 As the input for the track you want 2 1In the transport, press the REC but-
to record, choose an input channel of ton to begin recording.

the audio interface you are using.
Then press the REC FUNCTION but-
ton to enable recording for that
track.

00:00:06.350 €

EImEEE(E

STOP REC

File:  Edit Prajeci  Audic MIDD Pool Transport  Devices

press the STOP button, and then
press the REC button to disable
recording. Rewind if necessary.

© Cubase LE c ed
D [DGIEIRIE’ m ] [D] Dlol@l IUI\"] 3 When you are finished recording,
;|

REC FUNCTION

4 Repeat steps 1, 2, and 3 to overdub
additional tracks.

18 TASCAM US-122L
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6 — Recording with Cubase LE

Mixdown

1 Move the left and right locators to
specify the region that you want to
mix down.

Specify the region

From the File menu, choose Export ->
Audio Mixdown.

File  Edit
New Project
Open
Cloze

Project  Audio

MIDT Pool
CtrleN
CtrkO
el

Transport  Devices Wit

Save
Save fs

Sawe Project to Mew Folder..

Save as Template..
Revert

Ctr+3
Cri+3hift+3

Bare Setup.
Brimt

Impart

Cleanup..

Preferences.
Key Gommands...

Recent Projects

Quit

Crb+Q

3 In the Export Audio Mixdown dialog
box, make the desired settings and
then press the Save button.

Look in

[ Images

File name: Untitled Save
Files of type: [1ave File Grav? =l Garcel
Coding PCM / uncompressed Waves r
Atrbutes: -

C | - Ressltion [ [ Sample |
’VIMDnD d”’wsau d‘|’|umukm d‘

Import to
I¥ Automation I~ Pool
IV Effects I Avdio Track
A

TASCAM US-122L 19
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7 — Troubleshooting

This chapter lists frequently asked ques-
tions related to recording with Cubase LE,
with answers to these questions.

Q. I have finished making input
settings, but the meter of the
audio track is not moving.

A. Make sure that the monitor button of
the track is enabled.

€ Cubase LE Project - Urtitled

L]De]%']é EN ERREIDNEENE

Monitor

Q. I would like to record two
channels simultaneously for a
stereo recording.

A. Before you record, press the stereo/
mono select button of the track so that the
yellow indicator is lit. In this case, the
track input is shownas/n 7 +/n2ora
similar indication.

3B Audio 01 ___|
(o ][]

(B[]
LEl=lE]=]

Q. I am trying to use the EQ,
but it does not seem to do any-
thing.

A. Check the VST channel settings etc. to
make sure that EQ bypass is not enabled.

20 TASCAM US-122L

©Cubasze LE Project - Untitled

PEREND ERERCEHENE

Q. | mixed-down a song that
was three minutes long, but
the result was only ten seconds
long.

A. Make sure that the left and right locator
region is set to the entire range that you
want to mix down.

Q. | cannot set the locator
region to more than ten min-
utes.

A. The default setting is ten minutes.
From the Project menu, choose Project
Setup and adjust the length of the project.

€ Cubaze
File  Edit | Project Audio MIDI Pool Transport Devices  Winde
fidd Track

Bamave Salected Tracks
Show Uzed &otomation
Hid= All Automation

Fool Cir P
Markers Crr b
Tempn Track Citr BT
Beat Calculator..
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Q. | performed a mixdown, but
the automation and effects
were not reflected in the mixdown.

A. In the Export Audio Mixdown dialog
box, make sure that automation and effects
are enabled.

Look in:

|ilmages

File name: [Untitled Bave |
Files of type [Wave File Cmavt | Gance|
Coding, [P0 ¢ uncomprerzed wares =l
atnbutes: | -l

Charrels Resslution ~ Sawpie Ralz
“Mnno =l “1531 =] [#amkz E

I Inpoit o
¥ dutamation I~ Fod
W Efect: ™ Audo Track

5N

Q. I made a CD using the WAV
file | mixed-down, but the
speed is obviously different.

A. Could your project be set to 48 kHz?
If your ultimate objective is to create a CD,
we recommend that you work in 44.1 kHz
from the beginning.

To specify the sample rate, pull down the
Project menu, choose Project Settings, and
set the sample rate to 44,100 Hz.

Devi

Project  Audio  MIDI  Pool  Transport
Add Track 3
Bemove Selected Tracks
Show Usged Automation
Hide &ll Automation

Poal Cir[+P
Markers Cirl+
Tempo Track Ctr+T
Beat Calculator...

Motepad

7 — Troubleshooting

T
T

m Sterao Pan Law
Ok

Help | Cancel |

Q. Using the ReWire protocol,
can | record the incoming audio
on a track?

A. In Cubase LE, ReWire tracks do not
have recording capability.

You will have to export the audio data, and
then import it into an audio track.

Q. | have connected an audio
source to the US-122L, but can-
not hear anything.

A. Make sure that the input level is raised
appropriately. If the input is analog, the
green indicator will light when a signal is
being input.

Make sure that the monitor (or headphone)
level is raised, and that the connections are
correct.

Q. The sound is distorted.

A. Make sure that the signal is not over-
loading. The ideal level is when the red
indicator lights occasionally.
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8 — MIDI Implementation Chart

Function Transmitted | Received Remarks

Basic Channel At power ON X X Through
Changed X X

Mode At power ON X X Through
Messages X X
Altered Kkkkkkkkkkk kK

Note X X Through

Number Range Fokkk ko k Rk kKR

Velocity Note ON X X Through
Note OFF X X

After Touch Polyphonic X X Through
Channel X X

Pitch Bender X X Through

Control Change X X Through

Program Change X X Through
Range # *hkkkkkkkkkkkk

System Exclusive X X Through

System Common | :Song Pos X X Through
:Song Sel X X
‘Tune X X

System :Clock X X Through

Real Time :Commands X X

Other :Local on/off X X Through
:All note off X X
:Active sensing X X
:Reset X X

Notes

Mode 1: Omni on, Poly Mode 2: Omni on, Mono O:Yes
Mode 3: Omni off, Poly Mode 4: Omni off, Mono X:No
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9 - Specifications and performance

Audio specifications

Nominal input levels
MIC IN L and R (XLR balanced)

-58 dBu (TRIM=max) to 14 dBu
(TRIM=min)

MIC/LINE-GUITAR Land R in
MIC/LINE position (1/4” jack, unbalanced)

-40 dBu (TRIM=max) to +4 dBu
(TRIM=min)

MIC/LINE-GUITAR R in GUITAR
position (1/4” jack, unbalanced)

Maximum input levels
MIC L and R (XLR balanced)

-51 dBu (TRIM=max) to =7 dBu
(TRIM=min)

+2 dBu (TRIM=min)

MIC/LINE-GUITAR Land R in
MIC/LINE position (1/4” jack, unbalanced)

+20 dBu (TRIM=min)

MIC/LINE-GUITAR R in GUITAR
position (1/4” jack, unbalanced)

Input impedance

+9 dBu (TRIM=min)

MIC IN L and R (XLR balanced) 2.4 kQ
MIC/LINE-GUITAR L and R in 10 kQ
MIC/LINE position (1/4” jack, unbalanced)
MIC/LINE-GUITAR R in GUITAR 1 MQ
position (1/4” jack, unbalanced)
Nominal output level
LINE OUT (RCA unbalanced) -10dBV
Maximum output level
LINE OUT (RCA unbalanced) +6 dBV
Output impedance
LINE OUT (RCA unbalanced) 100 Q
Maximum output power
PHONES (1/4” stereo jack) 14 mW + 14 mW (32 Q)
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9 - Specifications and performance

Audio performance

Signal-to-noise ratio

LINE IN (through ADC and DAC) to LINE > 96 dB (A-weighted, TRIM=min., input

ouT

impedance at 40 Q)

LINE IN (through direct monitor) to LINE > 100 dB (A-weighted, TRIM=min.,

ouT

input impedance 40 Q)

Total harmonic distortion (THD+N, 22 Hz to 22 kHz)
LINE IN (through ADC and DAC) to LINE < 0.006% (1 kHz sine +20 dBu input,

ouT

TRIM=min.)

LINE IN (through direct monitor) to LINE < 0.0.04% (1 kHz sine +20 dBu input,

ouT

TRIM=min.)

Other characteristics

Digital audio

A/D Conversion (AK5381) 24-bit/96 kHz, 27.6 samples delay
D/A Conversion (AK4384) 24-hit/96 kHz, 19.3 samples delay
MIDI

MIDI IN and MIDI OUT ports (DIN 5-pin)
USB

Conform to MIDI standards

USB port (down stream connector) USB 2.0 Format
Host computer compatibility
Windows Windows XP
Operating system Macintosh Mac OS 10.3.9 or later
Communication USB 2.0
Audio/MID! interface Windows ASIO, ASIO2, GSIF2, WDM
protocols Macintosh CoreAudio, CoreMIDI (OS X)
Bundled software Cubase LE (for Windows or Macintosh),

Gigastudio 3 LE (Windows only)
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Physical characteristics

External dimensions (w x h x d)

147 x 192 x 48 mm

Weight

Supplied via USB

5V, maximum current 500 mA

Dimensions
—_— = ,
us-122L MIDIIN MIDI OUT  USB j
USBZ0 Audio/MIDI Interface © ©
m..Cm C
— —
nesy
S8
-~
une l: e PNAmcu u,‘,.:
&G °L llc/ aamn
TASCAM
e LNEIN  pHONES  LINEW g
. . . B .

147 mm
5.79 inch

48 mm
1.89 inch
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